CHAPTER 6

Image rectification

Typically, image rectification is the process of transforming an image from a file coordinate system into a map coordinate system. You can also rectify an image to a different satellite or pixel coordinate system. This process is also known as coregistering.

Rectification is accomplished by matching corresponding image and map points. These points are then used to compute the best fit polynomial transformation to align the image to the target map or image. The Align tool is designed to help you perform rectification.

You can use the Align tool in different situations including image-to-feature theme rectification and image-to-image rectification. You can even use coordinates that correspond to GPS (Global Positioning System) control points collected in the field with the Align tool.

In this chapter you’ll learn:

• The practical uses of the Align tool.
• How to change the defaults of the Align tool.
• How to use other rectification options.
• How to perform image-to-image rectification.
• How and why to either calibrate or resample an image.
Using images in map coordinate systems

The ArcView Image Analysis extension provides the Align tool for image rectification. The Align tool rectifies an image to a map coordinate system or the pixel coordinate system of another image. The reasons for rectification of an image vary, but practical applications include the following:

- You can use rectified images as backdrops to feature themes.
- You can compare an image in map coordinates to existing themes to help you determine land use.
- You can print a rectified image at the correct scale.
- You can use a rectified image to find the exact location of an area on the ground.
- You can use coregistered images to automatically assess temporal changes.
- You can alter the cell size of your images to a specific image resolution.

You can find many uses for your images once they are in a map coordinate system. The following example shows an Image Analysis theme and a feature theme drawn in the view aligned properly.

This simple example shows that images and feature themes can be aligned using the Align tool.

Changing alignment defaults of a theme

The Alignment panel defines the properties of the Align tool for the active theme. The Alignment panel is accessible by clicking the Theme menu, then choosing Properties.
Chapter 6  Image rectification

The Alignment panel controls default parameters for the collection of control points in the image.

The Alignment panel assigns the default parameters for use with the Align tool. The Default Link Color can be changed by clicking the color block and choosing another color from the Color Picker. You have access to both standard and custom colors there. Snap links to points, when enabled, allows the Align tool to attempt to snap To points to existing features. Snapping Tolerance works in conjunction with Snap links to points. It is measured in map units as proximity to the To point.

The parameters you select in the Alignment panel are only applicable to the active theme in the current view; they are not established as the default for the ArcView Image Analysis extension.

Introducing the Align tool

You can use the Align tool at any time you have two themes that are misaligned and at least one of them is an Image Analysis theme. It is the Image Analysis theme that can be aligned to the other theme(s). The Align tool may be used whether the themes are only slightly misaligned or in totally different coordinate systems. If both of your themes are active in a view, you may notice if you zoom to the full extent of the images that the two are nowhere close to one another. They only appear as small dots in the view.

To begin the alignment process, you simply need to make the Image Analysis theme you want to rectify active and then click the Align tool. The first click of the Align tool rescales the image and moves it within the extent or bounding box of the other themes in the view. The Align tool is then used to select control points that can be seen in both themes.
Note: If you have a large regional map and an air photo that only covers a small portion of the map, first zoom to the approximate area of the map that should contain the photo. Then, when you first select the Align tool, it initially aligns the photo with the subset of the map you zoomed to.

Collecting From and To points

The Align tool is designed to collect control points in an image that correspond to locations in a feature theme (e.g., a map) or another image. The points located in the image you wish to rectify are referred to as the From points. Points located in the feature theme or rectified image are called To points. A control point pair is made up of a From point and its corresponding To point, and is represented in the view as a graphic link.

Look for a ground location you can find in the image and on the feature theme or reference image. Click to select a From point in the image. After you select the From point, a rubber-banding line appears. This indicates you are to select the corresponding To point on the feature theme or reference image. At this time, the map coordinates are shown in the status area of the ArcView GIS window. You continue to select pairs of points in this manner until you are pleased with the alignment between the image and the feature theme or reference image.

This illustration shows control points positioned throughout the image. These points have been saved in a shapefile.

Once you collect at least four sets of control points between the image and the feature theme or reference image, a root mean square (RMS) error is displayed in the ArcView GIS status area. You can use Pan to Next Link, Pan to Previous Link, Pan to Worst Link, Zoom to Selected Link, or Display Link Error on the Align pop-up menu, accessed by clicking the right mouse button in the view, to see the RMS error for individual control point pairs.
Tips on collecting control points

There are some things to keep in mind about control points. You should not choose control points in areas that may change such as shorelines or forested areas. Better control points are stationary features such as road intersections and landmarks.

Also, you should be objective when evaluating the RMS error produced by a control point pair. The overall RMS error may be adversely affected by a single control point pair. In cases such as this, it may be wise to discard that control point pair unless you are absolutely sure of its accuracy.

In addition, when you choose control point pairs, you should always have them evenly distributed throughout the image. If you cluster control point pairs only in a certain area of the image, then your rectification is likely to be much less accurate as you move away from the points.

Finally, the larger your ArcView GIS window and view are, the easier it is for you to collect control points.

Editing control points

Your primary tool when editing existing control points is the Pointer tool. Because the control points are stored in a graphic layer on top of the image, you can use the Pointer tool to adjust their position. To move a From or To point, use the Pointer tool to select it, then drag the point to the new location. When you release the mouse button, it is in its new location. The RMS error is calculated and may be displayed in the ArcView GIS status area using the Align pop-up menu that is accessed by clicking the right mouse button in the view.
To delete a control point pair, use the Pointer tool to select it, then press the DELETE key on your keyboard, or you can click the control point pair and choose Delete Graphics from the Edit menu. If you wish to delete the control point pair you just created, use the Align pop-up menu to select Delete Selected Link.

**Saving control points as a shapefile**

Once you have collected your control points, you can save them as a shapefile. At the end of rectification, when you choose to calibrate or resample the image, you are prompted to save the control points as a shapefile.

If you choose to save the points you created, you save the control points as a shapefile with an .shp extension. The control point pairs are stored in a point shapefile. The To point is stored as the point feature’s coordinates, and the From point is stored as an attribute along with complete RMS information.

**What happens behind the scenes?**

After the first control point is taken, the image is shifted so the From and To locations line up. After the second control point is taken, the scale of the image is adjusted. With the third point, an affine transformation is calculated and the image is altered so that all three points line up. Starting with the fourth point, the RMS error is calculated and displayed for each control point pair.

As each control point pair is created, the polynomial transformation is calculated based on the number and distribution of the control point pairs in the image and the feature theme. As you collect more control point pairs, the order and complexity of the polynomial transformation may increase. The calculation is automatic and the image is redisplayed in the view.
Accessing other alignment options

While you are collecting your control points, you can use some additional options to help you navigate between the two themes. If you have the Align tool active, they can be found on the Align pop-up menu that is accessed by clicking your right mouse button in the view. The options are briefly described below.

Clear Selection

Clear Selection deselects links in the view. When you choose this option, no links are selected.

Delete Selected Link

Delete Selected Link deletes the currently selected link. As links are added, they are selected, so if you get unexpected results when adding a link, you can use Delete Selected Link to delete the link and return to the previous state.

Zoom to Full Extent

When you select Zoom to Full Extent, all of the themes in the Table of Contents are displayed in the view. Choosing Zoom to Full Extent from the menu is the same as clicking the Zoom to Full Extent button from the ArcView GIS button bar.

Zoom In

Zoom In functions like the one found in ArcView GIS with the exception that it zooms in by a factor of 2. It zooms in upon a smaller portion of the image in the view. That portion is centered in the view where the right mouse button is clicked.
Zoom Out

Zoom Out functions like the one found in ArcView GIS with the exception that it zooms out by a factor of 2. It zooms out so that a larger portion of the image is in the view. That portion is centered in the view where the right mouse button is clicked.

Zoom to Active Theme(s)

When you choose Zoom to Active Theme(s), the extent of the active theme fits in the view. This is the same as choosing the Zoom to Active Theme(s) button from the ArcView GIS button bar. Since you are doing an alignment, this option typically zooms to the extent of the image you are aligning.

Zoom to Selected Link

With Zoom to Selected Link, you can use the Pointer tool to select a control point. Zoom to Selected Link zooms in on the image by a power of 8, and is centered on the selected link so you can clearly see the point in the view. It also displays the RMS error for that point in the status area of the ArcView GIS window.

Zoom to Image Resolution

When you apply Zoom to Image Resolution from the right mouse menu in conjunction with the Align tool, the point you click is centered in the view. The view is zoomed so that the resolution of the image becomes 1:1.

Pan

Pan is useful if you find that you need to select a To point that is currently outside the display area. You can select Pan and move the image until the corresponding point is visible, then click to select your To point. The area you click on with the right mouse button is centered in the view.

Pan to Next Link

Pan to Next Link not only enables you to step through the links (a control point pair) you have created, but it also allows you to see the RMS error associated with the link in the status area of the ArcView GIS window. If you already have a link selected when you choose this option, it pans to the next link you created. If no link is selected, it starts with the first link you created.
Pan to Previous Link

You can use Pan to Previous Link to return to the link you previously created. In this way, you can move backwards through the links you have created as well as forward (using Pan to Next Link). You may find Pan to Previous Link useful when evaluating links for RMS error. RMS error is displayed in the ArcView GIS window’s status area.

Pan to Worst Link

The Pan to Worst Link is most useful after you have collected enough control points (four) to get an RMS value. You use Pan to Worst Link to find the least accurate link, or From and To point combination. This link adversely affects the rest of your error. Once you identify the link, you can evaluate it and possibly delete it. You may choose another location for your control point, or you may try to recollect the same point with greater precision.

Display Link Error

Display Link Error displays the RMS error of the selected link in the status area of the ArcView GIS window.

Image to Top

Image to Top is useful if you are working with two images that may obscure each other during the rectification process. Choose this option to bring the active Image Analysis theme (the image being aligned) in the Table of Contents to the top layer of the view. Use this when you are ready to collect a From point.

Image to Bottom

Image to Bottom is useful when you are working with two images that may obscure each other during the rectification process. Choose this option to send the active Image Analysis theme (the image being aligned) in the Table of Contents to the bottom layer of the view. Use this when you are ready to collect a To point.

Enter ‘To’ Coordinate

You use Enter ‘To’ Coordinate if you have a source of To points other than a feature theme displayed in a view. A good example of this is if you have an image and a corresponding set of GPS coordinates from the field. By selecting this option, you can enter those GPS coordinates directly into the To Point dialog as your To points. You enter To coordinates in this way on a point-by-point basis. First, select the From point in
the image, then select Enter 'To' Coordinate from the right mouse button menu. Type the X and Y coordinates of the To point, then click OK.

You can use the To Point dialog if you have GPS coordinates from field work.

Note If you have GPS points already in a file, create a point shapefile from them and turn on the Snap links to points in the Alignment panel to avoid typing them in.

Aligning an image step-by-step

The best way to show the features of the Align tool is to go through a step-by-step example. In Chapter 2, "Quick start tutorial," you learned how to use the Align tool to rectify an image to a feature theme. In this example, you'll learn how to rectify an image to another image. This process is a little more difficult because you cannot see through an image as you sometimes can with a feature theme. Therefore, you are going to use some of the other alignment options that are accessible with the Align pop-up menu.

The following example uses two images of Palm Springs, California. The image in need of a map coordinate system is a SPOT-5 image called palmsprings_spot-5s.png. The image that is already in a map coordinate system is an IRS-1C image called palmsprings_irs-1c.png. After the rectification process, palmsprings_spot-5s.png is aligned to palmsprings_irs-1c.png. You save palmsprings_spot-5s.png as a new image with the correct map coordinate system.

Start ArcView GIS

Load the ArcView Image Analysis extension
1. From the File menu, choose Extensions.
2. Click in the check box labeled Image Analysis and then click OK. This loads the ArcView Image Analysis extension.

Note The larger your ArcView GIS window and view, the easier this exercise is to complete.

Add and draw new Image Analysis themes of the Palm Springs area
1. Open a new view.
2. Click the Add Theme button.
3. Navigate to the avtutor directory. Double click on the ia_data directory under the avtutor directory.
4. Click the Data Source Types drop-down list and choose Image Analysis Data Source.
5. Hold the SHIFT key and click on palmsprings_irs-1c.img and palmsprings_spot-ss.img, then click OK.
6. Click the check box of the Palmsprings_spot-ss.img and the Palmsprings_irs-1c.img themes to draw them in the view. The themes do not appear at their full extents in the view. They may appear as dots. If you move your mouse into the top portion of the view, you see map coordinates displayed in the upper right corner of the ArcView GIS window.
7. Open the Legend Editor for Palmsprings_spot-ss.img and click the Infrared button. Close the Legend Editor.

Note: For the remainder of this exercise, the Palmsprings_irs-1c.img theme is referred to as IRS; the Palmsprings_spot-ss.img theme is referred to as SPOT.

Collect the first control point pair
1. Make sure that the SPOT theme is active in the view and first in the Table of Contents. This is the image needing the map coordinate system.

Note: To apply the Align tool, only one theme can be active in the view at a time. The active theme is the one needing a map coordinate system.

2. Click the Align tool. The ArcView Image Analysis extension attempts to draw the two themes in approximately the same space.

After you click the Align tool, the themes are both drawn in the view.
3. Click the Zoom In tool and zoom in upon the lower right corner of the SPOT theme. There is an airport runway located there. You may need to apply the Zoom In tool more than once to see the runway clearly.

The portion of the runway closest to the edge of the image has a distinct bright spot you can use for a control point. It is indicated with the yellow circle.

4. Click the Align tool, then click the bright spot in the middle of the runway (indicated by the yellow circle in the above illustration). This is your From point.

Now you see a rubber-banding line as you move the mouse around the image. This indicates you need to select your To point. You also realize that you cannot see the IRS theme in the view. That is the image where you need to collect your To point. To display the IRS theme, you can use some of the options available with the Align pop-up menu.

5. With the Align tool still active, click and hold the right mouse button, then select Image to Bottom. The active SPOT theme moves to the bottom layer in the Table of Contents.

6. If you cannot see the runway in the view, click and hold the right mouse button in the approximate location of the runway, then select Pan. When you apply the Pan tool, the portion of the image you click on is centered in the view. Continue to use Pan until you can see the corresponding point in the IRS theme.
Now you can see that the theme you are rectifying to, \textit{Palm springs_irs-1c.png}, is in the top layer of the view.

7. Click the corresponding To point in the IRS theme. The themes redraw in the view.

8. Click the Zoom to Active Theme button \( \mathbb{Z} \). Both themes appear in the view, and the control point you selected shows up as a red dot.

You can see the control point clearly in the grayscale theme of \textit{Palm springs_irs-1c.png}.

\textbf{Collect the second control point pair}

1. Drag the SPOT theme to the top layer in the Table of Contents or use the right mouse button and select Image to Top.

\textbf{Note} Remember to keep the SPOT theme as the active theme.
A red circle shows where you will collect your second control point pair.

2. Click the Zoom In tool and zoom in on the triangular area, which is located in the upper right portion of the theme (indicated with a red circle in the illustration above). You may need to apply the Zoom In tool more than once.

The triangular area is next to the road. There is an obvious point just outside the triangle that makes a good control point.

3. Click the Align tool, then click the point indicated above in the SPOT theme. It should appear as a bright red dot. This is the from point.

4. Use the right mouse button to select Image to Bottom.

5. Use the right mouse button to select Pan. Move the IRS theme until you can see the triangular area. It is above and to the right of the point you selected in the SPOT theme.
You can see the rubber-banding line in the view. Click the point just outside the triangle.

6. Select the To point on the IRS theme. The themes redraw in the view.

7. Click the Zoom to Full Extent button.

With the rectified IRS theme on top, you can see how the Align tool is beginning to make the SPOT theme agree with the map coordinate system. In this case, the SPOT theme must be rotated slightly to agree with the map coordinate system.

**Collect the third control point pair**

1. Click and drag the SPOT theme to the top of the Table of Contents or use the right mouse button and select Image to Top. Make sure it is active.
The next control point will be located in the upper left portion of the theme. It is indicated with a red circle.

2. Use the Zoom In tool to zoom in on the upper left corner of the theme. There is a road there that forms a 90° angle. You are going to collect the third control point there.

The 90° angle is where you are going to place the third control point.

3. Click the Align tool, then click the angle of the road in the SPOT theme. This is the From point.

4. Use the right mouse button to select Image to Bottom, then click to select the To point on the IRS theme.

5. Use the right mouse button to select Image to Top.

6. Click the Zoom to Active Theme button.
With the third point, the themes are fairly well-aligned. You only need one more control point pair.

Collect the fourth, and final, control point pair

The area where you are going to collect the final control point pair is in roughly the middle of the theme and indicated with a circle. There is an intersection in the shape of an X there.

1. Click the Zoom In tool, then click and drag a rectangle in the middle portion of the theme. The area from which you are going to collect the fourth point is indicated with a circle.
The road intersection in the shape of an X makes a good control point location.

2. Click the Align tool \[ \text{align tool} \], then click the intersection. This is your fourth From point.

3. Use the right mouse button to select Image to Bottom, then select the corresponding To point on the IRS theme.

With the fourth control point, the RMS error is reported in the ArcView GIS status area.

4. Look in the lower left portion of the ArcView GIS window; the RMS error is displayed there. Yours will likely be different than that illustrated above.

5. Use the right mouse button to select Image to Top.

6. Click the Zoom to Active Theme button \[ \text{Zoom to Active Theme} \].
Check the RMS error point by point

1. Make sure the Align tool is active, then click the right mouse button and select Pan to Next Link. The first link you selected, the airport runway, is centered in the view, and you can see its RMS error in the ArcView GIS status area.

2. Continue to click the right mouse button and choose Pan to Next Link until you have seen all of the control point pairs and their RMS errors in the view. You may want to click the right mouse button and select Zoom to Selected Link for a closer look.

Now that you have finished collecting From and To points in the themes, and have checked the control point pairs' RMS errors, the first step of the alignment process is complete. The next step is to resample the image you just rectified to produce an output file. You may choose to set some analysis properties as part of the resampling process. The next series of steps tells you how.

Set the analysis properties to match the SPOT image

Now you can set the analysis properties so that your resampled image is not too large for your system resources to easily manipulate. One way to do so is to set the cell size to a large number. The columns and rows of the image change according to the cell size.

1. Make sure that the SPOT theme is active in the view.
2. From the Image Analysis menu, choose Properties.
3. From the Analysis Extent drop-down list, choose SameAs Palmsprings_irs-1c.img. Note that the theme's coordinates are displayed in the Left, Top, Bottom, and Right text boxes.
4. In the Cell Size text box, type "20" to resample the image to 20 meters. Press the ENTER key on your keyboard. The Analysis Cell Size designation changes to AsSpecified. You can also see that the Number of Rows is 497 and the Number of Columns is 558.
5. Click OK in the Image Analysis Properties dialog.

Resample the Palmsprings_spot-xs.img theme

Since you've gone through and collected a reasonable number of control points and achieved an acceptably low RMS error, you should save your results. Resampling the image creates a copy of the image in its rectified position and preserves the original image.

1. From the Theme menu, choose Save Image As.
2. A Save Control Points dialog appears asking if you want to save the control point links in a shapefile. Click No.

Note For steps to save control points as a shapefile, see Chapter 2, "Quick start tutorial."

3. In the Save As dialog, move to the directory of your choice and name the new image palmresampled.img. Click OK. A status bar displays as the new image is resampled to 20 meters.
4. Click Yes to add the new rectified theme back into the view.
5. Make sure the SPOT theme is active in the view.
6. From the Edit menu, choose Delete Themes. Click Yes in the Delete Themes dialog.
7. Make the IRS theme active and click the Zoom to Active Theme button.
8. Click the check box of the Palmresampled.img theme to draw it in the view. Watch it draw over the IRS theme.
Choosing to calibrate or resample the image

Once you collect all of the control points, the RMS error is acceptably low, and the image is rectified to a map coordinate system, you have two options of how to save the image. You can either calibrate or resample.

Calibrating an image

If you choose the Theme menu and then Save Image, the image is calibrated. When you calibrate an image, you write the transformation information that has map information into the header. The transformation information stored in the header is used to display the image in the correct map coordinate system. This avoids producing a copy of the image, and leaves the original image intact.

The disadvantage of simply saving a calibrated image is that not all data formats keep the calibration information associated with the image internally. Resampling to a new file may be necessary in order to import the image into different GIS processing software and maintain the map coordinates, where calibration is not supported.

Note Files in the ERDAS IMAGINE .img format store the calibration associated with an image internally.

To calibrate an image

1. Make the newly aligned theme active in the view.
2. From the Theme menu, choose Save Image.

3. When asked to save the control point links click No. You have now stored the transformation information and calibrated the image.

You might also choose to calibrate an image if you want to continue using the Align tool at a later time. The image maintains the position you save it in, and you can continue the rectification from that point. However, the control points you collect during the first rectification process do not remain interactive with the file. You may choose to save the first set of control points as a shapefile to remind you of their placement throughout the image. When you use calibration in this way, you replace the calibration information each time.

Resampling an image

As an alternative to calibration, you may choose Save Image As to produce a resampled image. This option is particularly useful for TIFF and GRID data types that do not support calibration information outside of products such as ArcView Image Analysis extension or ERDAS IMAGINE.

As you saw in the image-to-image rectification example, when you resample an image, you produce an output image that you need to name. The original image remains unchanged. In the case of ERDAS IMAGINE files, the .img format allows the new image to store the map coordinate information internally. Other file types may store the map coordinate system information in an auxiliary (.aux) file that is created with the output file. The new image has all the usability as the original image, and it also has the map coordinate system you applied. You can verify this by reading the coordinates displayed in the upper right corner of the ArcView GIS window.

Note You can change the resampling preferences in the Preferences dialog. See Chapter 3, “Data types and data management.”

To resample an image

1. Make the aligned theme active in the view.

2. From the Theme menu, choose Save Image As.

3. When asked to save the control point links, click No unless you want to save them to a shapefile.

4. In the Save As dialog, move to the directory of your choice and give the output image a new name.
5. Click OK.
6. Click Yes to add the new image to the view. You now have two images.

**What next?**

As you have seen in this chapter, the ArcView Image Analysis extension's Align tool helps you coregister images with other images and Chapter 2 has shown you how to coregister images to shapefiles. The images can then be used in many different ways as you can see in the following chapters. For example, you may have a dozen or more aerial photographs covering your project area and do not want to go through your analysis steps 12 times each. The next chapter tells you how to create a single mosaic covering your entire project.